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The following is intended to outline our general
product direction. It is intended for information
purposes only, and may not be incorporated into any
contract. It is not a commitment to deliver any
material, code, or functionality, and should not be
relied upon in making purchasing decisions.

The development, release, and timing of any
features or functionality described for Oracle’s
products remains at the sole discretion of Oracle.
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. Refresher?

How many ....

- Siebel?

- JD Edwards (World or EnterpriseOne)?
- Peoplesoft?

- E-Business Suite?

ORACLE



. Overview of Bl Publisher
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. Oracle Bl Publisher

Oracle Standard Enterprise Reporting Platform

Data Sources Layouts Output Formats  Destination
Oracle i Publishing I e Email
Applications | Engine PDF  HTML EDI .
; R RTF Excel XML . * Printer
CRM ﬁ : - - e Fax

&

Fund Online

FMS n i i =y . Order
’ Templates @ :‘7&1 | T, Letters !_ Confirmations

scM n --------------------- Transfers I% Paychecks
_ . Bills =1 Government
_ Business = Grant Forms
Any Relational ‘? ] User ‘
Data Base

e

Integrated Out-of-the-Box with All Oracle Applications
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. Bl Publisher in Oracle Applications
Limited Use License

e Oracle E-Business Suite
In 11i -- 500 templates

In R12.1 -- ALL reports are Bl Publisher: 2724 templates and
2092 data sources or data templates across 95 products

Oracle Reports to Publisher Conversion Assistant

* PeopleSoft
Integrated into 8.48
Products shipping content in R9

* Financials e HCM e SCM
e Grants e CRM e Student Admin
e Siebel CRM

Integrated in 8.1.1 119 reports OOTB
Actuate to Publisher Conversion Assistant

ORACLE



. Bl Publisher in Oracle Applications
Limited Use License

* J.D. Edwards Enterprise One

Integrated into 8.96
Allow customers to develop their own templates

Subsequent releases will add Apps content
JD Edwards EnterpriseOne JDBC driver

* J.D. Edwards World

Integrated in A9.1
Produce XML that can be used as input to Bl Publisher
Automated integration in newly released A9.2

JD Edwards World JDBC Driver

ORACLE



Bl Publisher in Many Oracle Products

 Oracle ldentity Management * Oracle SOA Governance

* Oracle Life Sciences AERS * Oracle Retail

* Oracle Life Sciences Data Hub * Oracle Global Risk & Compliance

* Oracle FLEXCUBE Universal Banking ¢ iIFlex FLEXCUBE — IFLEX Reinsurance

* i-Flex FLEXCUBE Retail * Oracle FLEXCUBE Lending and Leasing
* Oracle FLEXCUBE Direct Banking * Oracle Communications Applications

* Oracle Reveleus * Oracle Transportation Management

* Oracle Mantas * Oracle Insurance Insbridge Rating and

- Agile Product Lifecycle Management for Underwriting

Process * Oracle Application Express (APEX)
« Agile Product Lifecycle Management * Enterprise Manager - Configuration Change
. : Console
* Oracle Hyperion Planning

* Oracle Hyperion Financial Management
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Actuate Report Development vs Bl Publisher Report

Bl Publisher (End User)

Development

Actuate (Developer)

1. Generate Report Object Library 1. Generate sample XML data
2.  Create report in Actuate 2.  Create report layout
3.  Compile report @

4.  Stop report server

5. Deploy report executable 3. Upload template
6. Associate report with View and 4.  Associate with a View
Deploy SRF

ORACLE



Generate XML Data
Create Template

Upload Template

Associate report
with a View

Without having to
restart the
application, you
can test your report

ORACLE
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Siebel — Steps for creating Bl Publisher Report

0 tunity List R £ D

Account Name Win % | Sales Stage Revenue
Agee - $535K Homeowner 40% 01 - Inquiry 500
Policy
Applaton - Checking B0% 05 - Activated 1000

Adams Marketing Adams - $100 MM IPO B60% 06 - Short List 7000000

Resourcas, Inc.

Addison Cabinet Co. Addison SB Loan 50% 07 -Loanis 5000

Booked

Addison Mfg. - Redding Adjustable Rate Mortgage 0% 04 - 275000
Oppty - Graan USD 450K Procassing

Atherton Group Agee - $450K Morlgage 5% 01- 450000
Application Qualification

Atherton Group Agee - 320K, Premium Savings | 0% 03 - o

Submitted

Balrd Distributors Adjustable Rate Mortgage 0% Lost/ 330000
Oppty - Franklin USD 600K Declinad

Dooley Law Firm LLC Adjustable Rate Mortgage 0% Lost/ No 400000
Oppty - Aarons USD 270K Decision

Dooley Law Firm LLC Adjustable Rate Morigage 0% Lost / 400000
Oppty - Boyd USD 300K Declined

Kingston Systems Adjusiable Rate Morlgage 0% 01 - Inquiry 2500000
Oppty - Axelson USD 150K

Parker Hospital Agee - Checking Account 0% 04 - 1]
Application Opportunity

Westemn Supply Company | Adam's request for credit card | 50% 03- 20000
line increase Qualification




. Actuate Reports Conversion Assistant

« Command line utility that converts the Actuate layout
design into Bl Publisher layout design.
* Actuate report layout convertor (from .ROD to .RTF)

e Avalilable to Bl Publisher customers at no additional
charge

 Available via patch number 8968224

ORACLE



What's new with Siebel 8.1.1.1 Fix Pack

* Integration with Bl Publisher Scheduling
« Parametized reporting (parameters can be entered when running a
report)
« Embedded reports server views into Siebel
— More features for embedded reports coming in 8.1.1.2
« Sample of Publisher reports provided out of the box
* Accounts:
« Account List
« Account Service Profile
* Enterprise Selling Plan — Overview
* Contacts:
« Contact List
» Contacts By Opportunity
» Alphabetic Phone List
e Opportunities:
* Opportunity List
* Opportunities By Sales Rep
* Pipeline Report By Sales Rep

ORACLE



For More Information on Siebel

» Siebel Reporting Migration Guide for Reports Developers
(Document 764191.1)

DATE TIME SESSION DESCRIPTION

4/22/10 12:15pm - 3630 Upgrading to Siebel 8.x
(Thursday) 1:15pm

ORACLE


https://support.oracle.com/CSP/main/article?cmd=show&id=764191.1&type=NOT
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. Embedded Bl Publisher for JD EnterpriseOne vs Bl
Publisher Standalone/JD Edwards EnterpriseOne

Bl Publisher is available to JD Edwards EnterpriseOne
users in two ways:

e Embedded BI Publisher for JDE1

— Need to produce content rich reports that are part of
the existing business process

 QOracle Bl Publisher Standalone with JDE1

— Need to empower business users to develop and
execute user driven reports

ORACLE



. Embedded Bl Publisher
8.98.1 adds capability to save output to a file system

Extract Transform Publish Distribute
o

g amd Publisher "
Printer

1111
T

Report Definition

File System

XML Repository New capability

ORACLE




. Oracle Bl Publisher Standalone with JD Edwards
EnterpriseOne

iy

Email
Layout Templates Printer
JDBC Driver i __/;.:-jﬂ_r;:‘:
ORACLE e — , &
Bl Publisher Fax
JDE F*“%i
EnterpriseOne * Word * Excel E Re%i;iiory

. b o FI
. ?[C)r(:v “ . Otehxe rs E %
e

e-Commerce

Layout Tools Output Formats  Destinations
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For More Information on JD Edwards EnterpriseOne

On support.oracle.com, search for 789074.1

DATE TIME SESSION DESCRIPTION

4/20/10 2:00pm - 76640 Bl Publisher and Oracle Bl for JD Edwards
(Tuesday) 3:00pm

4/21/10 1:00pm — 71170 Empower JD Edwards Users with Oracle Bl
(Wednesday) | 2:00pm Publisher for AD Hoc Reporting

4/22/10 9:45am — 73070 Reducing Cost with Oracle’s Bl Publisher

(Thursday) 10:45am

ORACLE
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. JD Edwards World release A9.1 or A9.2

*Use the “Export” feature to create data in XML

*A9.2 will automatically generates a nice Bl

Publisher report ORACLE
*A9.2 calls Bl Publisher APIs Bl Publisher

XML /

Export / Electronic XSD
Document Distribution
E \ Email
Address

ORACLE




. Oracle Bl Publisher Standalone with JD Edwards
World

iy

Email

Printer

Layout Templates

JDBC Driver

ORACLE
Bl Publisher

Fax

-Word  * Excel — f%r
« Acrobat - Flex P Y

» JDev  Others E %
i

e-Commerce

JDE World

Layout Tools Output Formats  Destinations
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For More Information on JD Edwards World

On support.oracle.com, search for 789078.1

The JD Edwards World JDBC Driver is downloadable
from Metalink’s Update Center.

DATE TIME SESSION  DESCRIPTION

4/21/10 10:30am — 70900 JD Edwards World — Technical Upgrade
(Wednesday) | 11:30am Considerations

4/21/10 1:00pm — 75460 BIP and JD Edwards World — Good Stulff!
(Wednesday) | 2:00pm

4/21/10 4:00pm — 76320 Using Oracle Bl Delivers to Send Reports to JD
(Wednesday) | 5:00pm Edwards Users
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ORACLE

Search:

Peoplesoft — Generate XML Data

Th CUSTOMER_LTR_FE4 - Microsoft Word

E'F_ilé Edit  ¥iew Insert Format Tools Table Window Help  Template Builder  Adobe PDF  Acrobat Comments
1Nl ATk B 0 o8 0 R EBLEY e @ meealie s B U oA

EDatav Insert ~ Preview = Tools ~ Help =

il
[] .

1

[> My Favorites
[ Wyorklist
[> Application Diagnostics
[> Tree Manager
<~ Reporting Tools
[ Gluery
[» PBInvision
[» BusinessOhjects
Enterprise
1L Publisher
[» Setup
— Data Soudrce
— Report Definition
— Content Likirary
— Translations

— #MLP Report Searc
— BEepott tlanager
[» PeapleTaools
— Change by Password
— My Personalizations
— My Systern Prafila
— My Dictionary

— Query Repart Yiews .
— Query Repatt Scheq -

ll-.g.‘-g---|L--1--L-|---|_2---||_---3-|_--|--|_-4---|_|---

x| FindMext |

| Find i
ORACLE :
b O @numirows
i - O @queryname
. XML PUBLISHER 3 @i
: - O @xsiinokamespaceSchemalocation
it [funbate E-EB Row
: o O @rownumber
O Business Unik =
O EBal Amk
i O Currency Cd
: O Addresst
: O City
~ GcusT_ID O state
i NAME1 O Postal
ADDRESS1 g omel =
1 CITY. STATE POSTAL A v
5 Example  MAMEL sample data
£ Dear Sirs/Madarm, Calculation | =] I onar
Welec ome to Nashville, TH! I™ Force LTR Direction
if According to our records as of <?$RunDate?=, we show the following open balance Mitchs | clce | Help
; : . i3 |Click Insert,
il Business Unit Remaining Amount -
- F BUSINESS_UNIT | $988 89E s
@
' Veanr tatal mitota ndine halanca ic SEPGBHENAR E
= eEl=®n< |

joows o puoshepes s N NTIO M IH A G B St ALS i

ORACLE




Peoplesoft — Report Definition

reporting To

ﬁ XML Publisher Edit "ML Publisher" Falder

MLP report instances.
[ﬁ Content Library

Create and maintzin reusable Sub-Template
definitions.

[> My Favorites
[ Wyorklist

[> Application Diagnostics
[> Tree Manager
=~ Reporting Too
[ Gluery

[» PBInvision

[» Business Ok 1 = Query Report Viewer = Query Report Scheduler
Enterprise ASSOCIate a d ata’ Sou rce E Fun Guery-bazed XML reports realtime. E Schedule Guery-bazed XMLP reportz. Use to
- W|th a tem plate . g in @ wincon. run bursted reports.
Prepare for using xhL Publisher.

Grant security to view e
report =] Design Helper

Register XML-bazed repart templates and translationg:

E Data Source
Register schema and sample data files for

Report definitions are used to:

Eﬁ“ Report Definition

Define reports by associating Data Sources
weith layout Template files.

Define output options.
Setup

b PeopleTools | Define bursting options.

— Change by PaESwETO
— My Personalizations
— My Systern Prafila

— My Dictionary

ORACLE



Peoplesoft — Running Bl Publisher Reports

Home

Search: Mew Yindow | Cu:
L My Faworites Query Report Viewer
DWD”.{““. . : Enter any information you have and click Search. Leave fields blank for a list of all values.
[ Application Diagnostics
[ Tree Managet *Search by: | ReportM
~ Reporting Tools
> Query Search | Advanced ¢ ORACLE
[ PSiniision XML PUBLISHER
[> BusinessOhbjects Search Results
}Eh;tflr:'pnhef . Report Definition ﬁ
ol uhlisher HEUG
b Setup Report Name Desc :
— Data Source CLUSTOMERLETT Cust 10012 ,
- Report Definition 4400 Hacienda Drive
— Content Likbra CUBT_LET cuUs Pleasanton, CA 94588
— Translations [9_BURSTIMG 19 Fo Dear Sreftiad
— Query Report Yiewer ear Sirs/Madam,
- Query BRepart Scheduler I9_PRINT 14 Fo Welcome to Nashville, TN!
— HMLP REDDH Search TEST Cust According to our records as of 03/122006, we show the following open balances.
— Eeport Manader _ S _
Cros Business Unit Remaining Amount
[ PeopleTools FREWIM Listi US005 $690.63
— Change Wy Password US006 5100.00
— Wy Personalizations usoo7 $500.00
— hiy System Profile Your total outstanding balance is $1,290.83.
— Iy Dictionany . ) .

ORACLE



. New Bl Publisher Features with PeopleTools 8.50

* PDF Full Path Mapping

* Descriptive Report Names

e Support for Emaill
 Alternative XML Preview

« XDO Properties Configuration
* Iterative Template Design

ORACLE



For more information

* Release Notes for PeopleSoft Enterprise PeopleTools 8.50

« Enterprise PeopleTools 8.50 PeopleBook: XML Publisher for
PeopleSoft Enterprise

DATE TIME SESSION DESCRIPTION

4/20/10 8:00am - 4349 Creating XML Publisher Documents with
(Tuesday) 9:00am Peoplecode

4/21/10 8:00am - 75220 XML Publisher Tips for PeopleTools
(Wednesday) | 9:00am

4/22/10 9:45am - 72360 PeopleSoft Recruiting Enhancements You Can
(Thursday) 10:45am Use

ORACLE




. Program Agenda

* Overview of Bl Publisher
* Bl Publisher in Oracle Applications

« Application integrations with Bl Publisher
— Siebel CRM
— JD Edwards Enterprise
— JD Edwards World
— PeopleSoft
— E-Business Suite

* Appendix

ORACLE



. XML Publisher Releases
vS. E-Business Suite Releases

e Release 11.5.10
— XML Publisher 4.5 — 12/31/04

e Post Release 11.5.10
— XML Publisher 5.5 — 01/06/05

* Performance, Translation, Template Builder,
Common Regions

— XML Publisher 5.6 — 01/10/06
« Administration Ul, Data Engine, Book Binder

* Release 12
— XML Publisher 5.6.3
* Runtime Optimization, Enhancements

ORACLE



e T bl P e b

E-Business Suite - .

i e

Release 12 and 12.1

— HRMS using many government s e
forms from all around the world B ‘ """""

<fanfStatamant=

Payments utilizing Publisher for Banking and Credit
Card payment processing

— Financial Applications has consolidated many data
sources and providing multiple templates

— Oracle Reports to Bl Publisher Conversion Assistant

ORACLE



XML Publisher
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Setup and Process — Overview

DEVELOPMENT SETUP B USER PROCESS [

Create Data and Layout
Template Files

A 4

\ 4

Load files and
Metadata to
Template Manager

A 4

Define concurrent
Program using the
data engine executable

A

Add concurrent
Program to
Request Group

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

D:D Automated process
o ORACLE



. XML Publisher — Concurrent Program Process Flow
EBS

Two Step Publishing
1. Submit Oracle report with output format set to XML.

2. After request completes submit XML Report Publisher and
select the completed output of your request and a template to
run against.

One Step Publishing

» Submit the original program (output type = XML), at runtime
select the template and output format (RTF, PDF, EXCEL).

» The program being submitted is usually the old Oracle Report
61 request. The request is run and OPP manager submits XML
Publisher to create PDF.

ORACLE



. XML Publisher — User Process

— User selects the report from a list
— User enters parameter values

— User can select a template, language and output
format and submit the report

— User can view the final output via the Monitor
Requests form

ORACLE



User Selects the Report From a List and Enters
Parameters

O Submit Reguest
Fun this Request. ..

Mame |Concurrent Program Details Report - XML Publisher
Operating Unit
Parameters

Language |American English

Language Settings. .. . Debug Options

At these Times...
Run the Job |42 Soon as PodediGIlE el

Application Mame
Lpon Completion... J
V' Save all Qutp Program
Layout Program Details
Notify ] Qanceljl Clear jl Help J,I
Print to  noprint
Help (©) | ( submt | Cancel |

ORACLE



. User Can Select a Template, Language and Output
Format

O Upon Completian... l

 Save ll O s 1. User can select a
Layout:
Template Mame Template Language Format For Language
II Program Details - Simple| anlish: United States | PDF | AMERICARN = d Ifferent template

from the LOV
i) , 2. Then a different

Motify the following people: Ianguage |f available

MName For Language
! - 3. Then an output

format
Print the Output To: T
Style |Landscape

Printer Copies For Language

I naprint a All languages =
Help ] Cancel J

ORACLE



User Can View the Final Output via Monitor
Requests Form

Refrash Data

Find Requests

T-TES
Reguest ID Parant e £ ew Docuent Tods Wedow Heb ~l8lx]
MName | | Blseeacey = @ P sowen ||| 7 Trooiect G || @ 51| -0 @50 - @ || 00| @ne- || wr| gDl
= —
|Luading.. (Migrate Enterpris e
; . ] . -
. |8954E|24 |Load|ng.. (Migrate Enterprit oOrRACLE Invoice R SR
| | | 500 Oracle Parkway
Redwood Shores
| | | CA 94085 B
usa
| | | Tel: + 650 507 000
\ Invoice Address Fax: + 650 507 000
k | | | Attn: Accounts Payable
| | | Field B F F Page 1 of 2
| Mottingham
Phoenix Centre T T
| | | Millenium Way West _ Inv.mca Information
Nottingham NG8 6AW Invn!oe Number: 200402
| | | Invoice Date: 29-JUL-04
| | | _Payment Terms: Immediate
Payment Due: 20-AUG-04
tnvoice Code: | NIIIINIVHIVHNMIARIARIANNN Your VAT #: 23423646434
( Hold Reguest “Wiew Details. .
Description uom Quantity Unit Price | VAT % Total Net
( o R i Di i 200402: Test Line 1 Shest 5000 0.5 17.50 726.00
Leain] imsues G e 300402: Test Line 2 Sheet 5000 0.15 17.50 726.00
200402: Test Line 3 Sheet 5000 0.15 17.50 726.00
200402: Test Line 4 Shest 5000 0.15 17.50 726.00
200402 Test Line § Sheat 5000 0.15 17.50 726.00
200402 TestLine 6 Shest 5000 0.15 17.50 726.00
200402: Test Line 7 Sheet 5000 0.15 17.50 726.00
Z0040Z: Test Line B Sheet 5000 0.15 17.50 726.00
200402: Test Line 9 Shest 5000 0.15 17.50 726.00
200402: Test Line 11 Sheet 5000 0.15 17.50 726.00
200402: Test Line 12 Sheet 5000 0.15 17.50 726.00
200402: Test Line 12 Sheet 5000 0.15 17.50 726.00
200402 Test Line 14 Sheet 5000 0.15 17.50 726.00
20040Z: Test Line 15 Sheset 5000 0.15 17.50 726.00
200402: Test Line 16 Sheet 5000 0.15 17.50 726.00
| 200402 TestLine 17 Sheet 5000 015 17 60 72600 | li=
= oAl & o pl| 09 Ll i

CcLe




Output Post Processor (OPP) Manager

* Note 291792.1 — Using the OPP in Oracle Applications
Concurrent Processing

OPP is an extension to Concurrent Processing
Takes care of all post-processing actions for concurrent requests
Required for single-step reporting using XML Publisher.

Triggered by Conc. Manager upon completion of the XML output
generation

« Maximum throughput defined as:

#processes X #threads = MAX #parallel reports
If needed, increase the default values

 Profile Options:
— Concurrent: OPP Response Timeout
— Concurrent: OPP Process Timeout

ORACLE



OPP Manager Setup

« The OPP Service is multi-threaded and will start a new thread for each
concurrent request it processes.

 You can control the number of simultaneous threads for an OPP Service
Instance by adjusting the Threads per Process parameter for the instance.

- If all the OPP process have reached their respective maximum number of
threads, the requests waiting to be processed remain in a queue to be
processed as soon as threads become available.

Weork Shifts (A Return to Top

| Add warl Shifts
Select ltem and ... (_Remove
Select Name Description Processes Threads Per Process
& Standarg ~Ctive 24 1 5

haours every
day
@ TIP Threads per Process should be between 1 to 20

ORACLE



. Detailed Process Overview (1 of 2)

1. Choose a report to publish in XDO.

To avoid breaking the seeded Concurrent program, copy
the current program to a new name (such as Active
Users XML) using the Copy Program functionality in
FNDCMMCP. This provides a new Alias but doesn’t
touch the seeded definitions. Any patches to the seeded
program will update the copy as it points to the seeded
program. Only maintenance is the need to update the
parameter list if the seed programs parameters are
changed. Add the report to a responsibilities
report/request group.

ORACLE



. Detailed Process Overview (2 of 2)

2. Change the output format to XML and run the report to
get a sample data set.

3. Using the XML data, create an RTF template in the
Template Builder (Or you can create a PDF or XSL-FO
template.)

4. Create a Data Definition and Template definition in
Applications as XML Publisher Administrator.

5. Link Template to Report using System Administration
responsibility (Self-Service).

6. Setup OPP manager.
Submit the request and view the output.

8. Enable printing of the report (To print PDF output
requires pasta and ghostview or acroread.)

ORACLE
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Getting XML Sample or Runtime Data

E-Ur-:-:l-: Applications - Yision
Eila Edit Yiew Foder Tools Window Help

(HPO S5V SP 2 DM

> 3 Find Requess

O My Completed Bequests
CrMy Requests In Pragress
w2 My Requests

~ Specific Requast
Request ID
MName

Diate Submitted
Date Completed
Status

FPhaze

Reguestor

L include F.

Ordar By  Reguest E
Select the

Submit a Mew Request, .,

ORACLE

E;f;r:lsh Diata | | Find Reguests J Submit & Mew Reguest. _J

Reguest ID Parani

Marma Phasa Stalus Requasior Priority

[Active Users [Completed  [Hormal [SYSADMIN o =
(2756338 [Active Users XML [Completed  [Normal [SYSADMIN [s0
2756337 |Verify Concurrent Manag | Completed  Mormal  [SYSADMIN 0
(2756336  [Purqe Debug Log and Sy Pending  Scheduled  SYSADMIN o
2756335  [Synchronize Workflow L | [FEiding ) SeREUEEY sysaomin [0
(2756334 [Synchronize WF LOCAL 2755346  [Completed  Nermal [SYSADMIN T |
(2796332 |Synchronize WF LOCAL 275536  Completed  [Normal [SYSADMIN E]
(2796330 |Synchronize WF LOCAL 275536  Completed  [Normal [SYSADMIN |50
(2756326 |Synchronize WF LOCAL 2755346  [Completed  [Normal [SYSADMIN [s0
(2756326 |Synchronize WF LOCAL 7755346  Completed  [Normal [SYSADMIN =

.r d Requeel | Wiew Details. . J iew Output
nce| Request (- Diagnostics D Wiew Log..




Getting XML Sample or Runtime Data

racle Applications - Yision

File Edit Wiew Foider Toos \Window Help
HYO I &EVSP R NDER LD PH I BT

o> = Flnd Requesls

Ty Completed Requests
My Requests in Pragress
A My Requests
~ 2 Specific Requests
Request 1D
Name O Reguests
Date Submitted | . "
Dete Completed ! Refrash Data Find Requests Submit & Mew Request..
Status | Requesl D Parant
Phase I Marma Phasa Status Reguasior Priority
Requestor | "!?5633!! Active Users Completed Normal SYSADMIN 50 =
© Reguest Diagnhostics DMIN 50
Includa lI DEAIN il
Ordar By Request | Request [0 2756339 DMIN 50
Phase |Completed DMIN 50
Select th . ke
Statee Normal DRIN S0
Submit 3 bew Request Hame Active Users DEIN 50
DEIN S0
This request completed successfully. The request started at 12.SEP.2005 09:45:42 = DMIN 0
|and ended on 12-SEP 2005 09:46:18. DMIN 50 =
Cutput
Log..
C [ vewaie D | o | ‘

ORACLE



XML Sample Data

T heep: nanndi- po.us.or acle.cone OO0/ 08 _CGE FNDWIRRLesetemp_id =2604230086 - Microsoft Intemet Explorer =l0] x|
| Fle Edt View Favarktes Toole Hep 'iii
| #=gech - = - @) H] A | Dhsearch [EyFavortes Preda F S-S B |
| Address @] tittp:inmodi-oc.us orace.com:E000/0A_CGIFNDYRR. sxeitemp_id=2604230086 z| oo [junks™ | F - |

-

<?xml version="1.0" ?>
Zl-- zenarated racl
- <FNDSCURS>
- <LIST _OSAF_FIRST QUERY>
- <OSAF_FIRST_QUERY>
<H=X<fX>
- <LIST_BREAK>
- <BREAK=>
<USER_NAME />
<SECURITY GROUP MNAME=>Standard</SECURITY GROUP MNAME>
- <LIST_G_RESPS>
- <G_RESPS>
<APPLICATION NAME>Self-Service Web
Applications</APPLICATION_NAME>
<RESPONSIBILITY NAME>Preferences
SSWA</RESPONSIBILITY NAME=>
<START DATE>232-JUL-02</START _DATE>
<END_DATE />
<fG_RESPS:>
- «G_RESPS>
<APPLICATION_ NAME>Service Contracts</APPLICATION MNAME>
<RESPONSIBILITY NAME>Service Contracts Electronic
Renewals</RESPONSIBILITY NAME>
<START_DATE>23-JUL-03</START_DATE>

Re| arsion 6.0.8.24.0 —-->

4|

. o

& I

[ et

ORACLE




XML Publisher

ORACLE



. Development Setup — Overview

— Create Data Template
— Create Layout Template

— Register data and template definition metadata and
load data template and layout template

— Define concurrent program
— Add concurrent program to request group

ORACLE



Create Data Template

- _ < dataTemplate name="dataTemplatelName" description="Template description”
dataSourceRef="0ORCL" defaultPackage="employee® version="10">
Define —<parameters>=
Parameters <parameter name="department” dataType="character” defaultValue="10"/>
L </parameters>
Peiina —m-<dataQuery>
Data Query - <sglStatement name="0Q1">
SELECT EMPNO ENAME SAL from emp where deptno=department
</sglStatement>
—»</dataQuery>
$:S;eers —p-<dataTrigger name="beforeReport” source="employee beforeReportIngger"/>
—=<dataStructure>
- <group name="G_EMPLOYEE" source="Q1">
Define Data <element name="EMPLOYEE_NUMBER" value="EMPNO"/>
SR <element name="IAME" value="ENAME"/>
<element name="SALARY" value="SAL"/>
</group>
—p»</dataStructure>

—  </dataTemplate>

ORACLE



Create Layout Template

I 0pen Balance - Letters.rtf - Microsoft Word

© Ele Edt Wew Insert Format Inols  Table  Window  Help  Orace XMLFublisher  Template Buldsr

NBHR &R FE$RRSI-6-8FTAREE T 9 -@\mm!
44 Normal -0 -|B LU \.___ EEO-YL A ! ‘Data - Insert = Prewew'Tuu\s'He\D'!

- Arial

~=1alx]

Type a question for help— ~ X

L — AT R SRR RN R SRR AR SRR AR I

ImportHeaderFooter

|

15 Sme  Ermployers state 10 number

]

E

3

16 Slate woges, Ups, @i,

17 Slate income oy

Bt

18 Local wages, tps, slc.

$

3

19 Local moome tax

. ESTEICRIITRRRI R,

3

Wage and Tax
Statement

|
Form W‘ 199

Copy A For Social Security Administration—Send this entire

Please confirm the above information.

B E =R page with Form W-3 to the Social Security Administratiorn:
forawe [ [ fuoshepese N\ \ OO E A S BE|P-LZ-A-==2 8@ phaotocopies are not acceptable.
Page 1 Sec 1 11 ALY ln3 col2 REC TREEXT OVR English (U.S

c003

Cal No. 10134D

Dapartment of the Treasury—inernal Ravenue Service
For Privacy Act and Paperwork Reduction
A

Motice, see separate instruclions.

Do Not Cut, Fold, or Staple Forms on This Page — Do Not Cut, Fold, or Staple Forms on This Page

A =18l x
- CUSTOMER_NAME : 3 .
ADDRESS_LINE | 2 Hiswmseer o @ Pseoen || ) Troit g [ 8- 5[5 @[Fw - @ |03 @ue- [0 wt EEE I
- ADDRESS_LINE2 T »
h ADDRESS_LINE3 =
ADDRESS_LINE4 i
. CITY
T gl.ll;ATE i a Contral numbes 22222 For Official Usa Only »
v [ OMB No. 15450008
; b Employer ientification rmber 1 Wages, tps, othes compensation 2 Federal income tax withhekd
3 b
Dear Sirs/Madam € Employer's name, addrass. and ZIP coda 3 Sccll sacurlly wages 4 Soclal security tax wihinek
N ' 3 ]
According to our records as of 1 Jan 2003, w B iachodea: Waget: pac g W DR e WAL
) FYour USD balance is $1,000.00, macdle up as $ b
. 7 Sockal sacurlty Tips 8 Allocated tps
- GS 3 3
Invoice Date TRANSACTION DATE d Empkyee's social securfy numbar Tl 8 Advance eI payment |10 Dependont care benafits T
B 5 $
N Invoice Invoice & Employes's first name and initial Larst maame 11 Hongualified plars gz» See Instructions for box 12
: Number Type T . A3 3 E;
. F TRX_NUMBER TRANS_TYPE 1l e e 1k
- o s |
14 Omer 12
] [$
- 2 I
N I Cmployea's address and ZIF coda W;/W/Mf

oG | 04

N

-0
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Create Layout Template

I 0pen Balance - Letters.rtf - Microsoft Word

© Ele Edt Wew Insert Format Inols  Table  Window  Help  Orace XMLFublisher  Template Buldsr

NBHR &R FE$RRSI-6-8FTAREE T 9 -@\mm!
44 Normal -0 -|B LU \.___ EEO-YL A ! ‘Data - Insert = Prewew'Tuu\s'He\D'!

- Arial

~=1alx]

Type a question for help— ~ X

L — AT R SRR RN R SRR AR SRR AR I

ImportHeaderFooter

|

15 Sme  Ermployers state 10 number

]

E

3

16 Slate woges, Ups, @i,

17 Slate income oy

Bt

18 Local wages, tps, slc.

$

3

19 Local moome tax

. ESTEICRIITRRRI R,

3

Wage and Tax
Statement

|
Form W‘ 199

Copy A For Social Security Administration—Send this entire

Please confirm the above information.

B E =R page with Form W-3 to the Social Security Administratiorn:
forawe [ [ fuoshepese N\ \ OO E A S BE|P-LZ-A-==2 8@ phaotocopies are not acceptable.
Page 1 Sec 1 11 ALY ln3 col2 REC TREEXT OVR English (U.S

c003

Cal No. 10134D

Dapartment of the Treasury—inernal Ravenue Service
For Privacy Act and Paperwork Reduction
A

Motice, see separate instruclions.

Do Not Cut, Fold, or Staple Forms on This Page — Do Not Cut, Fold, or Staple Forms on This Page

A =18l x
- CUSTOMER_NAME : 3 .
ADDRESS_LINE | 2 Hiswmseer o @ Pseoen || ) Troit g [ 8- 5[5 @[Fw - @ |03 @ue- [0 wt EEE I
- ADDRESS_LINE2 T »
h ADDRESS_LINE3 =
ADDRESS_LINE4 i
. CITY
T gl.ll;ATE i a Contral numbes 22222 For Official Usa Only »
v [ OMB No. 15450008
; b Employer ientification rmber 1 Wages, tps, othes compensation 2 Federal income tax withhekd
3 b
Dear Sirs/Madam € Employer's name, addrass. and ZIP coda 3 Sccll sacurlly wages 4 Soclal security tax wihinek
N ' 3 ]
According to our records as of 1 Jan 2003, w B iachodea: Waget: pac g W DR e WAL
) FYour USD balance is $1,000.00, macdle up as $ b
. 7 Sockal sacurlty Tips 8 Allocated tps
- GS 3 3
Invoice Date TRANSACTION DATE d Empkyee's social securfy numbar Tl 8 Advance eI payment |10 Dependont care benafits T
B 5 $
N Invoice Invoice & Employes's first name and initial Larst maame 11 Hongualified plars gz» See Instructions for box 12
: Number Type T . A3 3 E;
. F TRX_NUMBER TRANS_TYPE 1l e e 1k
- o s |
14 Omer 12
] [$
- 2 I
N I Cmployea's address and ZIF coda W;/W/Mf

oG | 04

N

-0
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. Register Data Definition

Use XML Publisher Administrator responsibility

Create data definition metadata

Load sample data and schema if required (only pdf layouts)
Load data template file

Data Definitions

Wb

Search

Name | Code |
Application | Q Active I‘r‘es 'I

General

Personalize Stack Layout: (GeneralStackRn)

- rorly

Open Balance Supplier Letter Data * Marme |Supp|ier Data * Code IAPXCOBLX

VETS-2000 DataSource * application IOracIe Payables Q * Start Date I29-Aug-2DDE| =)
End Date I E

Customer Listing Summary =

FSG program Description  |nats for suipplisrs B

Contract Terms Data Definition

Project Contracts Data Source

Standard Purchase Order Data Source

Blanket Purchase Agreement Data Source

<) Previous |1-1E| VI Next 10 &




Register Layout Template

1. Use XML Publisher Administrator responsibility
2. Create layout template metadata
3. Load template file

View Template: Supplier Balances Letter

General
Templates
Personalize "General Information”
Search
Update Edit Configuration
Mo I_ MName Supplier Balances Letter Code APXSOBLX_1
Application Oracle Payables Data Definition Open Balance Supplier Letter Data
Application I Type RTF Start Date  01-Mar-2004
Default File apxsobbx-2.rtf End Date
Type I
Default File Language English Subtemplate
Go Default File Territory United States
Description |gypplier Balance Letter Template B
Hame
Supplier Balances Letter i

Supplier Balances Letter - Green

Template Files
VETS-2000 Template
Personalize "Template Files"

Personalize Stack Layout: (Files.PreviewFormatRn) .
Add File
Preview Format IPDF j 4

Customer Listing Summary - Simple

Localized Templates

Personalize Stack Layout: (Files.LocalFilesLayoutRn)

FSG: Basic Template

File Name Language Territory Preview Download Update Delete
Contract Terms Layout Template for| |apxsobl-2.rtf English United States

l
O
S

Oracle Contract Terms Template




1.

Use System Administrator responsibility
2. Create a concurrent program definition using the XML

Publisher Data Template executable

O Concurrent Programs

Fragram
shart Mame
Application
Description

Executahle

Supplier Open Balance Letter

APESOBLY
Oracle Payahbles

Supplier Balance Letter

Marm

ADODTEXE

Options

Method

Request
Type
Incrementar
MLS Function

M Use in SRS

[TRun Alone
[ Enakble Trace

Copy to...

Java Concurrent Prograrm

[ Allow Disabled Yall
¥ Restart on System
W MLS Compliant

Session Contry

Priarity

Cutput

==Y, koA |

O Concurrent Program Executable

W Enabled

Define Concurrent Program & Executable

Executable XML Publisher Data Termplate Executahle

Short Name #DODTEXE
Application XML Publisher

Description ML Publisher Data Ternplate Executahle

Execution Method |Java Concurrent Program

Execution File Name |JCP4xDODataEngine

Subroutine Name

Execution File Path oracle.apps.xdo.oa.cp

Stage Function Parameters

ORACLE




Add Program to Request Group

O Request Groups

Group |Receivables All
Application Receivables
Code

Cescription Al reparts and programs

Reguests
Type Marme Application
l Frogram - Wnrkﬂnvﬁ Background Process Application Ohject Library =
Frograrm - |ADS Financials seneral Ledger
Frogram = ||Publish B Reports Assets
Frogram - ||Collection Effectiveness Indicators Feceivahles
Fragram - ||Autainvoice Import Pragram Feceivables
Frogram = lAging - ¥ Buckets - By Amount Report {of Receivables i
Frogram = lAging - 4 Buckets Report Receivables
Frogram - lAging - ¥ Buckets - By SalespersonfAgent Receivables
Frogram = lAging - ¥ Buckets Report (ohsolete) Receivables
Frogram = |Billing and Receipt History Feceivables -

Description  Workflow background process for deferred and timeout activities

ORACLE



Run the Report

1. Switch from System Administrator to the appropriate

responsibility

2. Select Concurrent: Run

3. Select any parameters need for the request

Control : Requests

& Set

wi you to submit an individual request.
' Request Set

This allows you to submit a pre-defined set of
requests

Ok | Cancel J

ORACLE

C Submit Request
Run this Request...

Marne
Cperating Unit
Pararmeters

Language

At these Times. .

Rurn the Joh

Upon Completion...

Layout
Motify
Print to

Help (C)

Supplier Open Balance Letter

O01-JAM-2008: Ace Glass Inc.o0:0:

As Soon as Possible

M Save all Qutput Files

Supplier Balances Letter - Green

noprint

%

Submit

Copy...

Debuy Options

Schedule.

Options. ..

Cancel J




. Bl Publisher Desktop 5.6.3

e Bl Publisher Desktop 5.6.3 (10.1.3.2)

* 5.6.3 =10.1.3.2 for Enterprise users, same basic code tool
can be used to login and connect to 10.1.3.2 Bl Publisher
Enterprise.

e Patch 5887917 Oracle XML Publisher Desktop Patch 5.6.3
Includes

— Template Builder for Word

— Template Builder Tutorial

— Template Viewer

— RTF, PDF and eText examples.

ORACLE



. XML Publisher References

* Note 364547.1 — Troubleshooting Oracle XML
Publisher For The Oracle E-Business Suite

* Note 737311.1 — How to Configure the Account
Analysis Report in Release 12 for Large Reports

e XML Publisher 5.6.3
— Note 422508.1 - About Oracle XML Publisher Release 5.6.3

— Oracle XML Publisher Administration and Developer's Guide
Release 12 B31412-01

— Oracle XML Publisher Report Designer's Guide Release 12
B31410-01

ORACLE



. Fax Your Documents through RightFax Server

* Deliver faxes directly from the Bl Publisher Delivery
Manager to any fax destination and query the status
of the job using RightFax 9.3 or above.

* Implemented by the Oracle Collections team for the
Strategy Dunning Program.

 Blog article by Pradeep K. Sharma

— http://blogs.oracle.com/xmlpublisher/2009/07/now fax your
documents through 1.html

ORACLE


http://blogs.oracle.com/xmlpublisher/2009/07/now_fax_your_documents_through_1.html
http://blogs.oracle.com/xmlpublisher/2009/07/now_fax_your_documents_through_1.html

For more information

DATE TIME SESSION DESCRIPTION

4/20/10 10:30am — 4726 Moving to Bl Publisher, Now What? Automated
(Tuesday) 11:30am Fax and Email from Oracle EBS

4/20/10 2:00pm — 3356 Custom Check Printing Framework using XML
(Tuesday) 3:00pm Publisher

4/20/10 2:00pm — 3815 Smart Reporting in Oracle Financials Release

(Tuesday) 3:00pm 12.1

ORACLE




. Program Agenda

* Overview of Bl Publisher
* Bl Publisher in Oracle Applications

« Application integrations with Bl Publisher
— Siebel CRM
— JD Edwards Enterprise
— JD Edwards World
— PeopleSoft
— E-Business Suite

o Appendix

ORACLE



. For More Information

Publisher Home Page

http://www.oracle.com/technology/products/xmi-publisher/index.htmi

Publisher Demo Catalog

http://www.oracle.com/technology/products/xml-publisher/demoshelf/Shelf.html

Publisher Blog

http://blogs.oracle.com/xmlipublisher/

Publisher Forum

http://forums.oracle.com/forums/forum.jspa?forumiD=245

* White Paper — Converting Crystal Reports to Oracle Bl Publisher
http://download.oracle.com/otndocs/xmlp/CrystaltoBIP.pdf

ORACLE



. For More Information

http://search.oracle.com

10

Bl Publisher

or

http://www.oracle.com/technology/products/xml-publisher

ORACLE



DATE

TIME

Bl Publisher sessions....

SESSION

DESCRIPTION

4/19/10 2:30pm — 213 Introduction to Oracle Business Intelligence
(Monday) 3:30pm Publisher

4/19/10 3:45pm — 217 Bl Publisher Hands on Lab

(Monday) 4:45pm

4/20/10 8:00am — 218 Oracle Business Intelligence Publisher Best
(Tuesday) 9:00am Practices

4/21/10 1:00pm — 243 Oracle BIEE End-to-End

(Wednesday) | 2:00pm

ORACLE




Troubleshooting

ORACLE



. Agenda

 EBS Basic Setup — Administration
* Troubleshooting Basics
 Location of Log Files

e Turning on Debug

« Setup for Large Reports

ORACLE



. EBS Basic Setup — Administration

Basic setup to prevent JAVA memory errors use the
XML Publisher Administrator responsibility.

1. Navigate to Administration > Configuration.

2. Select a Temporary Directory for Bl Publisher.

Preferably not APPLCSF as this area already has a lot of
I/O. Must be a valid path on the concurrent processing
node and the web node.

3. Setthese XSLT properties to true:
— Use XML Publisher's XSLT processor
— Enable XSLT runtime optimization.

ORACLE



XML Publisher Administrator:
Administration > Configuration

2N Configuration - Microsoft Internet Explorer,

File Edit Wi Faworites Tools Help %
~. - o 3 ; - !
e Back -~ » ’,.,.: f "] P ! Search %5 Favorites €‘} = '3
Address |@ http: ffisulliva-pcs.us . oracle, com:S000)OA_HTMLIOA, jsp?OaHP=+D0_TEMPLATE _MARNAGERBOAPE=XDO_BRAMDINGEROASF=XDO_COMNFIG_UPDATE_MEMNU&pac | Go Links > @& -
- = #
Configuration -
Reset I Save |
Expand all | Collapse all
e
Focus Properties Site Walue
= Properties
@ = General
Temporary directory |x’tmp
Ry POF Cufout
R POF Security
Rt RTF Output
Rt HTRL Ot
L3 = FO Processing
Font mapping set || | Q,
Currency format set | -
Bidi language digit substitution type |
Pages cached during processing |
Disable variable header support
Add prefiv to IDs when merging FO
Use XML Publisher's XSLT processor
Enable scalable feature of X5LT processar
Enable ®XSLT runtime optimization
Compress temporary files
HELT extension classes |
@ RTF Templates 0
@ POF Templates
@ HLIFF Extraction
. , B
&=] %ed Local intranet

CcLe




. Troubleshooting — Getting Started

« Get error log showing specific error.

* Improve error messages by turning debug on.
* Try to replicate on internally.

* Requires layout template and XML data file.

ORACLE



. How to Get Bl Publisher Log Files

> One Step Publishing Concurrent Requests:
Request Log: Requests > View > Log

Output Post Processor Log:
a. Navigate to Concurrent Manager Administer.
b. Select the Output Post Processor.
c. Choose the "Processes" button.
Select the process that was active during the time you are
interested in.
d. Choose the "Manager Log" button.

» Two Step Publishing — XML Report Publisher
Request Log — Requests->View->Log

» Increase logging by turning on Debug for these processes.

ORACLE



% Oracle Applications - Yision
File Edil View Folder Too's Window Help

2P0 &8 HP| € [

= administer Concurrent Managers

& Concurrent Processes

Manager MName Output Post Processor

How to Get the Log File of the OPP

Made HMODI-PC

.— Concurrent Processes

=~ Manager IDs =~ Request IDs
Status Concurrent Oracle System Running System Start Date
| Active 750931 35 1437 07 SEP-2005 16:31:49 =

d I I
| | |
| I |
d I I
| I |
| I I
| | |
| I |
d I I
| | |

|
| I
| |
| |
| I
| |
| |
| |
| |
| I
| |

|
|
|
|
|
|
|
|
|
|

|
|
|
|
I
|
|
|

Service Infa |?5l]!]31: 2 service threads running

—

| Reguest Log

Internal Manager Log

Mdanager Log ) y

|

Open

—

ORACLE



How to Get the Log File of the OPP

3 http:/ /nmodi-pc.us.oracle.com:8000,/0A_CGI/FNDWRR.exe?temp_id=3186825€

[0 x|
=

|

|€| Daone

J File Edit Yiew Favorites Tools  Help
J d=Eack - = - B} ﬁ| Qhsearch  [GFavorites GMedia &4 | -5 &
JAddress |g“| http: {irmodi-pe. us. oracle.com: 300004 _CGLFNDWRR. sxertemp_id=3156525650 x| e |JLinks ”|J & -
[9/8/05 10:43:47 AM] [750931:RT2756310] Starting XML Publisher post-processing action.

[5/8/05 10:43:47 BM] [750831:RT2756310]

Template code: FNDSCURSZ

Template app: FND

Language: en

Territory: us

output type: RTF

[5/68/05 10:58:01 AM] [750531:RT2756310] XML Publisher post-processing action complete.

[5/68/05 10:58:01 AM] [750531:RT2756310] Completed post-processing actions for request 2756310.
[5/8/05 11:02:17 AM] [0OPFServiceThreadl] Post-processing request 2756311.

[5/68/05 11:02:17 AM] [750531:RT2756311] Executing post-processing actions for request 2756311.
[9/8/05 11:02:17 AM] [750931:RT2756311] Starting XML Publisher post-processing action.

[5/8/05 11:02:17 AM] [750831:RTZ2756311]

Template code: FNDSCURSZ

Template app: FND

Language: en

Territory: us

output type: EXCEL

[5/68/05 11:10:20 AM] [750531:RT2756311] XML Publisher post-processing action complete.

[8/8/05 11:10:20 AM] [7505931:RT2756311] Completed post-processing actions for request 2756311,
[9/12/05 9:46:1% AM] [OPFServiceThreadl] Post-processing request 2756339,

[5/12/05 S:46:15% AM] [750531:RT2756339] Executing post-processing actions for request 2756339.
[5/12/05 S:46:15% AM] [750531:RT2756339] Starting XML Publisher post-processing action.
[3/12/05 5:46:15 BM] [T750831:RTZ2756339]

Template code: FNDSCURSZ

Template app: FHND

Language: en

Territory: us

output type: PDF

[9/12/05 9:4%:0% AM] [750931:RT275633%] XML Publisher post-processing action complete.
[5/12/05 $:45:05% AM] [750531:RT2756339] Completed post-processing actions for request 2756339.
Kl |

s

l_ l_ l_ E Local intranet 4
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. How to Turn on XDO Debug in EBS R12

Turn on debug on the concurrent processing node.
1. Select node_name, status, support_cp, support_web from fnd_nodes;
2. For each node identified as active (status="Y’) for support_cp and/or
support_web = Y’ do:
a. Create a directory temp under $XDO_TOP.
b. Create a directory resource under $XDO_TOP.
c. Under $XDO_TOP/resource create a file xdodebug.cfg.
This file has only two lines:
LogLevel=STATEMENT
LogDir=<absolute path to $XDO_TOP/temp on the current node>
d. The applmgr user (owner of the $SAPPL_TOP file system) needs rw
permissions on both directories created under $XDO_TOP.

e. Test your program.

Debug files are generated in $XDO_TOP/temp. They include: .xml
data file, .xsl template translation, .fo formatted output, .out output, and
xdo.log which is a detailed log of the process.

ORACLE



. Debug for the XML Report Publisher

* As System Administrator, Navigate to
Concurrent > Program > Define.

e Query up XML Report Publisher (XDOREPPB).

« Change the Debug Flag Parameter to Visible
(checkbox).

* Run the Request, set the Debug Flag Parameterto Y.
* Request log will now be more detailed

ORACLE



Oracle Applications

File Edit ¥iew Folder Tools

Window Help

Yo & BSP RODLRE L@ D5 2

Debug for the XML Report Publisher

=1/
ORACLE

current Prog

Executable

Request

M Use in SRS
[T Run Alane

[ Enable Trace

Frogram
Short Mame HDOREFPFE
Application  *ML Publisher
Description |Senerate POF from existing XML output and XML Publisher Template
Mame }(

Mlethod ;J-éva-éoncurrenth-'rogram

Copy to...

PFE

Type
Incrementor
MLS Function

Ll Aowe Disabled “alues
W Bestart on Systermn Failure

M MLS Compliant

_J Session Control

DOptions
Priority

Cutput

Farmat

Columns
Rows
Style

Printer

Incompatibilities

[ Enabled

[PDF -]
¥ Save (C)
v Print

[ Style Reguired

| I Farameters )

Y

‘e start

acle appli by = Applicati

equests (System Administrator b

ORACLE




Oracle Applications

File Edit “iew Folder Tools

HEYO & EBS P

Window Help

CRHAe L@ DG ?

Debug for the XML Report Publisher

S(=1/E3
ORACLE

Program XML Report Publisher

Application [¥mL Publisher

Security Group

-

= Conflicts Domain
Seq  Parameter Description
|20 Template Template
H E éTempIate Locale éTempIate Locale
l;SD - EDebug Flag éDebug Flag
'EF éTempIate Type éTempIate Type
“alidation
“alue Set E-‘:f‘es.-"No
c Default Type |Constant
O [ Required [ Enahle Security
O
[ Display
Display Size 4
Concatenated Description Size a
| Taken ?DebugFIag

Description
Default “alue
Range

Description Size

Frompt

-
Enahled
| R e
v
ol
TR
¥
50
jDebug Flag

Ets (Systern Administrator B

le Applications

ORACLE




. Debug for the XML Data Template Extract —
XDODTEXE

* As System Administrator, Navigate to
Concurrent > Program > Define.

e Query up the report using XDODTEXE as its
executable..

« Add a Parameter Debug Flag.
— Value set should be yes_no
— Default value should be Y.
— Select checkboxes Enable and Required.
— Token needs to be DebugFlag (case sensitive value).

— If you select the check box Displayed, users can turn this off
at runtime. In production you will usually want the default to
be ‘N'.

ORACLE



Debug for the XML Data Template Extract —
XDODTEXE

Eile Edit Wiew Folder Tools Window Help ORACL

HYO 58 LP £ DDHHER L@ P51 7

] _Ix
Functions Documents
Oracle Applications Manager: L%
Oracle qE
+
&+ Program |GL Cash Clearing Account Analysis Report
=" Application |General Ledger
+
*| oE
#’ . Conflicts Damain Security Group
& ]
+ . Seq Pararmeter Description Enahled
= G0 From Accounting Period From Accounting Period [
+ R 70 To Accounting Period To Accounting Period Iw!
+ a0 Detail/'Sumrmary Layout Detail/Sumrmary Layout 2
=0 Debug Flag S
“alidation
walue Set [Yes/MNo Description
e Default Type |Constant Default Value |Y
O W Reguired [T/ Enable Sacurity Range hd
m
¥ Display
Display Size 40 Description Size |50
Concatenated Description Size 25 Prompt |Debugy Flag
| Token |DebugFlag
]




. Debug for the XML Bursting Report —
XDOBURSTREP

* The program definition comes seeded with a
DebugFlag parameter.

e If called using fnd_request.submit_request then the
DebugFlag parameter should be set to ‘Y.
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Debug for the XML Bursting Report —
XDOBURSTREP

File Edit Wiew Folder Tools Window Help

HeO &r8SP L hEe L@ 4% 2
E - 0O x
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Method Java Concurrent Program Priority
Reqguest E = [=]
Program |XML Fuhlisher Report Bursting Program
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Conflicts Domain | Security Group
Use in SRS .
[l Run &lone ~ Seq Parametar Description Enahled
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’F |Request [n] |Request [n] v
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Copy o ,7 | &
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Walue Set |Y957N0 Description |Th|5 walue set only contains °
Default Type |SQL Statement Default Value |Belect meaning from FHND_LC
[ Required [ Enable Security Range I:
W Display
Display Size 10 Description Size ’507 Q
Concatenated Description Size 25 Prompt |DehugFIag
Taken |DebugFlag




. Set Up for Large Reports

 Many large reports in R12 use XDODTEXE to
generate the XML data file extract.

* The output is generated by merging the data and a
layout template by the Output Post Processor (JAVA)
concurrent manager.

* There are two bottlenecks for these reports:
XDODTEXE and the OPP both require tuning to avoid
JVM memory Issues.
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Set Up XDODTEXE For Large Reports

The log of this program will show this error:
Calling XDO Data Engine...
****\Warning!!! Due to high volume of data, got out of memory exception...***

****Please retry with scalable option or modify the Data template to run in scalable
mode...***

As System Administrator:
1. Navigate to Concurrent > Program > Define.
2. Query up the report.
3. Add a parameter: Scalable Flag
Value set should be yes _no
Default value should be Y.
Select checkboxes Enable and Required.
Do not select the check box Displayed, or users could turn this off at runtime.
Token needs to be Scalable Flag (this is a case sensitive value).
Under Execution Options enter -Xmx1024m.
If the error persists this value may need to be increased (I suggest .5 GB intervals.)

ORACLE



. Set Up the OPP for Large Reports

The Output Post Processor log will show this error:
"lJava.lang.OutOfMemoryError: Java heap space”

Configure the Output Post Processor's JVM.
These steps set the JVM to 2GB, depending upon the server's size you
might find 3 GB (-mx3072m), 4GB (-mx4096m) or even 5GB (-mx5120m)

is a better value.
Login to SQL*Plus as APPS.

SQL>update FND CP_SERVICES set

DEVELOPER_PARAMETERS =
"J:oracle.apps.fnd.cp.gst.GSMServiceController:-

mx2048m*
where SERVICE_ID = (select MANAGER_TYPE from

FND_CONCURRENT QUEUES
where CONCURRENT QUEUE NAME = "FNDCPOPP"):

Bounce the concurrent managers.
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. XML Publisher References

* Note 364547.1 — Troubleshooting Oracle XML
Publisher For The Oracle E-Business Suite

* Note 737311.1 — How to Configure the Account
Analysis Report in Release 12 for Large Reports

e XML Publisher 5.6.3
— Note 422508.1 - About Oracle XML Publisher Release 5.6.3

— Oracle XML Publisher Administration and Developer's Guide
Release 12 B31412-01

— Oracle XML Publisher Report Designer's Guide Release 12
B31410-01
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